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Please read the following notes

1. All information included in this document is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice.

2. Polabs does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of
third parties by or arising from the use of Polabs products or technical information described in this document. No
license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of
Polabs or others. PolLabs claims the copyright of, and retains the rights to, all material (software, documents, etc.) contained in
this release. You may copy and distribute the entire release in its original state, but must not copy individual items within the
release other than for backup purposes.

3. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of the products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. PoLabs assumes no responsibility for any losses incurred by you or third
parties arising from the use of these circuits, software, or information.

4. Polabs has used reasonable care in preparing the information included in this document, but PoLabs does not warrant that
such information is error free. PoLabs assumes no liability whatsoever for any damages incurred by you resulting from errors in
or omissions from the information included herein.

5. Polabs devices may be used in equipment that does not impose a threat to human life in case of the malfunctioning, such
as: computer interfaces, office equipment, communications equipment, test and measurement equipment, audio and visual
equipment, home electronic appliances, machine tools, personal electronic equipment, and industrial robots.

6. Measures such as fail-safe function and redundant design should be taken to ensure reliability and safety when Polabs
devices are used for or in connection with equipment that requires higher reliability, for example: traffic control
systems, anti-disaster systems, anticrime systems, safety equipment, medical equipment not specifically designed for life
support, and other similar applications.

7. Polabs devices shall not be used for or in connection with equipment that requires an extremely high level of reliability and
safety, as for example: aircraft systems, aerospace equipment, nuclear reactor control systems, medical equipment or systems
for life support (e.g. artificial life support devices or systems), and any other applications or purposes that pose a direct threat
to human life.

8. You should use the PolLabs products described in this document within the range specified by PolLabs, especially with respect
to the maximum rating, operating supply voltage range and other product characteristics. PoLabs shall have no liability for
malfunctions or damages arising out of the use of PoLabs products beyond such specified ranges.

9. Although Polabs endeavors to improve the quality and reliability of its products, semiconductor products have specific
characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions.
Further, PoLabs products are not subject to radiation resistance design. Please be sure to implement safety measures to guard
them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a PolLabs
product, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction
prevention, appropriate treatment for aging degradation or any other appropriate measures.

10. Usage: the software in this release is for use only with PolLabs products or with data collected using PoLabs products.

11. Fitness for purpose: no two applications are the same, so PolLabs cannot guarantee that its equipment or software is
suitable for a given application. It is therefore the user's responsibility to ensure that the product is suitable for the
user's application.

12. Viruses: this software was continuously monitored for viruses during production, however the user is responsible for virus
checking the software once it is installed.

13. Upgrades: we provide upgrades, free of charge, from our web site at www.poscope.com. We reserve the right to charge for
updates or replacements sent out on physical media.

14. Please contact a Polabs support for details as to environmental matters such as the environmental compatibility of
each Polabs product. Please use Polabs products in compliance with all applicable laws and regulations that regulate the
inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. PoLabs assumes no liability for
damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

15. Please contact a Polabs support at support@poscope.com if you have any questions regarding the information
contained in this document or PolLabs products, or if you have any other inquiries.

16. The licensee agrees to allow access to this software only to persons who have been informed of and agree to abide by these
conditions.

17. Trademarks: Windows is a registered trademark of Microsoft Corporation. PoKeys, PoKeys55, PoKeys56U, PoKeys56E,
PoKeys57U, PoKeys57E, PoKeys57CNC, PoRelay8, PoScope, PoLabs and others are internationally registered trademarks.
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1. PoBlocks description

PoBlocks is a graphical programming tool for PoKeys devices. It features an intuitive and clean interface

and enables the user to quickly and easily design, deploy and debug a program that gets transferred and

executed by the PoKeys device itself.

PoBlocks was developed with ease of use in mind, which means that it does not require long manuals,

extended tutorials, or deep knowledge to use. Although PoBlocks is simple to use, it also boasts a rich

set of features - support for PoKeys basic and extended 1/O interfaces support, timers, counters,

configurable clock sources, algebra, memory, logic and non-linear operations, time schedule, event

drums, even PID and on/off controllers, etc.

PoBlocks also features a simple to use monitor mode for debugging that gives user a good insight in how

the program executes in real-time.

2. Main features

Simple and intuitive graphical user interface with integrated support: just open the application
and start designing your diagram. Drag the function blocks from the graphical toolbar with
mouse and connect them by clicking on the input/output ports. When in doubt, hover over the
block to access the integrated help.

Support for wide array of PoKeys peripherals: PoBlocks gives you the access to digital inputs
and outputs, analog inputs, PWM outputs, encoder inputs, digital counters, PoExtBus outputs
and more just by dragging a block and selecting the pins in the property panel on the right.
Algebra, logic blocks: Choose from basic algebra functions and logic functions to create simple
conditional logics.

Memory blocks: use JK, D, T or data latches, minimum/maximum value memories, simple RAM
blocks.

Trigger and timing functions: PoBlocks offers counters, signal level triggers, on-, off- and pulse-
timers, etc.

Advanced blocks: weekly time schedule, LCD interface support with multiple layouts, drum-style
programming, process control etc. Advanced blocks enable you to quickly start controlling your
process as you want it. If no block suit your needs, custom PolL and ST code blocks enables to
define a new block in code and seamlessly include it in the diagram.

One-click compiling and downloading: when satisfied with your design, compile it and
download it to the device with only one click.

Real-time debugging/monitoring: with PoBlocks, your diagrams are simply created, then
compiled and downloaded to the device with one click. When it comes to debugging or
monitoring the process, simply activate the monitor mode and all outputs and connections will
be populated with current values.
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3. Requirements

e Windows XP, Vista, 7, 8, 10, 11
e Visual C++ 2019 Redistributable Package installed on the target computer
® PoKeys56, PoKesy57 or PoRelay8 device (on USB or network)

4. Installation

PoBlocks application is a part of the PoKeys software installation package, available free of charge on

WWWw.poscope.com.
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6. Polabs PolL core introduction

PoKeys PolL core is a virtual 16/32-bit software processor, which interprets PolL code in PoKeys device
and has access to various PoKeys peripherals.

PolL code is created in the compiling process in the PoBlocks application and is stored in the flash
memory of the PoKeys device.

6.1. Operating modes

PolL core has the following operating modes:

- STOPPED: PolL core is stopped and no code is being executed

- RUNNING: PolL core is executing code

- EXCEPTION: PolL core encountered an error and execution had to be stopped

- PAUSE: PolL core is temporarily halted and when restarted, continues from this point

6.2. Start-up configuration

When PoKeys device is started (power is applied), the PolL core can be reset (initialization code
executed) and PolL code execution can start automatically. By default, PolL code is not automatically
executed on reset (Auto-start is disabled).

6.3. Cycle time

The PollL core supports priority-based pre-emptive scheduler that switches between two (or more on
later versions) tasks. Task O has the lowest priority and is enabled by default. Other tasks are periodic
tasks that have a fixed time-period between executions. Task switching is done at 1 ms intervals or on
task exit events.

Task 1 is automatically used and enabled by PoBlocks software for executing the PollL code of the
diagram when periodic mode is selected (when cycle time, greater than 0 is specified). In this mode,
minimum cycle time for execution is limited by the code size, but cannot be lower than 1 ms. In non-
periodic mode (cycle time set to 0), task 0 is used and cycle time depends solely on the PolL code size.

PoBlocks features an integrated Task manager that displays the target and actual cycle times of the tasks
being executed (Task manager is found in PoBlocks application menu under ‘Tools > Task manager’). For
more details, see ‘Task manager’ below.

6.4. PolL programming

PoBlocks enables low-level PollL language programming using the custom PolL block. PolL processor and
instructions documentation is available as a part of the PoKeys setup package — look for PolL.pdf
document in the installation folder.

9 www.poscope.com
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7. User interface

PoBlocks user interface is displayed below. Top area contains menu bar, tolbar with device controls and
block library. Bottom left area is diagram design area, while the right part is reserved for properties
panel that contains dynamic properties of project or currently selected block.

Device controls

Toolbar
W PoBlocks 2.0.0.0 [C:/../Examples/Scheduled configurable temperature control.xmi] P a x
Menu bar
Algebra Logic Memory Trigger /tming Extended Control Communication Misc
" ~ o
s & El ] o BEOE i ey P
Block Ilbra ry Digtaliput  Dighaloutput  Analog rput  PWMoutput  PWM outputC Encodervaue Digie counter EssySensors vt oo UsB key
. . Project IPVwShES Shared data  Memory info
Navigation
Project properties
C p=m)
Execution
Disable divisio.. [] False
Auto start [ False
Reset coreon ... [] True .
Grteime 10 Properties
)
Date
i ) = ” Atoreload pr... [] False pa nel
towiemy Author
. (e s e T
Design area =
(
[ ——
( " e
.
- 4
Mouse: [255, 289] Connected to PoKeys57CNC [21000]

7.1.Toolbar and device controls

Toolbar gives the access to most-frequently used functions of the PoBlocks application. Besides creating
new, opening and saving the designed diagram, 'Compile and transfer' button enables one-click
compiling, checking and transferring of the diagram to the device. If the code is already running the
device, a dialog appears asking user to confirm the download procedure.

Device controls panel enables user to interact with the PolL core in the PoKeys device.

Device selection

Start PolL code
execution

Disconnect .
Monitor mode Reset PolL core Stop PolL core

The following controls are available:

- Switch to PoKeys application: disconnect and open PoKeys application for advanced peripheral
setup and testing. This option is only available if PoKeys application is installed to the default
installation path.

- Disconnect: click this to disconnect from current device
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- Device selection: this opens a device selection dialog to select a device to download the PolL
code to.

- Monitor mode: clicking the Monitor mode button enables or disables the real-time monitor
mode (this is available after the diagram has been successfully compiled and downloaded to the
device).

- Reset PolL core: use this command to reset the PolL code execution.

- Stop PollL core: this command stops the PolL code execution.

7.2. Device selection dialog

Device selection dialog is used to select a PoKeys device to work with. All detected devices are displayed
in the list and selecting a device refreshes the device information panel, giving the user information on
device's name, its serial number, current time and status of PollL core activation. All PoKeys devices are
shipped with PolL core disabled and user must enable the core once prior downloading the diagram to
that device. This is accomplished by clicking the 'Enable/disable' button (note: enabling PolL core
disables keyboard macro capability of PoKeys56U devices).

PoKeys devices with a holder for a RTC battery support RTC (real time clock) that can be used for
scheduling the events. RTC in the device is set to current computer time by clicking the button 'Set time'.

" Device selection X

Select the PoKeys device from the list below: Refresh

PoKeys57CNC (PoKeys57CNC) [21000]
PoKeys [200] @ 192.162.88.99
PoKeys [20000] @ 192.168.88,112

or enter IP address: I:I Select

Device info
Device name: PokKeys37CNC
Serial number: 21000
Time: 10:02:10 14.10.2021 (Thursday) Set time
Poll core: enabled Enable/disable
External core: | Mone (default) w
Connect Cancel
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7.3. External core selection

PoBlocks also supports deploying the project to external cores (e.g. PoRelay8). To select the external
core, select the host PoKeys device first in the list of PoKeys devices, then select the target device from
the drop-down list ‘External core’. Check the documentation of the target device for the information on
how to enable the external core functionality.

" Device selection *

Select the PoKeys device from the list below: Refresh

PoKeys5TCNC (Pokeys37TCNC) [21000]
PoKeys [200] @ 192.168.88.99
PoKeys [20000] @ 192.168.88.112

or enter IP address: I:I Select

Device info
Device name: PoKeysS57CHMC
Serial number: 20000
Time: 10:04:43 14.10.2021 (Thursday) Set time
PolL core: enabled Enable/disable
External core:  [Mone (default) -

Example: enabling external core support on PoRelay8

Use PoKeys application to connect to the host PoKeys device. Then open PoExtBus Smart peripheral
configuration dialog and select the PoRelay8 device in the list (note that the PoRelay8 must be
connected to host PoKeys device via the PoExtBus connection). Click on ‘More’ and select ‘PolL core’
greater than 1 in the settings. Confirm by clicking the ‘Set’ and ‘Save settings’.

s PoExtBus Smart e
Detected devices: Refresh
Seq.  Device type Device |D Version  Timeout e xdmo.nal S;e:.lngsb I il
anging settings below wil
[ 1 PoRelayd[Bidge] A7I0C74  v20 5 Ly alloupuss O affect the compatbilty of the
" :PoRelayE RO/ V1.0 5 Tum all outputs OFF g?nvalﬁed':'s:wc:tsher PoExtBus
? PoRelayd A7103157 v1.0 0 Trires mrErTTooE
3 PoRelayd AT10313E v10 7 Sequence 1D: device directly to PoExtBus
1 . for recovery.
Failsafe timeout: s
5 +| s 250k (default) ~
CAN base D (hex)
108 3

(confim by Enter) | Set
Save settings

PollLcore: (0 [+ |Set
(0=dizabled, confirm by Enter)
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7.4.Block library

Block library panel contains graphical representations of function blocks in the PoBlocks library. The
library is divided into block categories and tabbed menu system is used to switch between these. Each
block in the block library offers integrated help system (see the figure below) that gets activated by
hovering the mouse cursor over the block.

To insert the block from the library into the diagram, drag a block using mouse cursor from the block
library into the diagram.

o poBlocks 2.0.0.0

; [ﬁ E | Check and Transfer

File Edit View Tools Help

STOP Run

SN Algebra  Logic Memory Trigger / timing Extended Control  Communication  Misc

e * W Ar a T T
o B i) [ A B o 57 — e e G
Digital input  Digital output ~ Analoginput ~ PWMoutout  PWM outoutC  Encoder value Digital counter  EasvSensors Pms PoE));Ij:S USE key
Jelr "

Project Gl Shared data  Memary info
PWM output is used to set the duty cycle of the PWM {pulse width modulated) output & Property Value
Parameters: Project properties
- Pin ID: PoKeys pin ID as indicated on the device General
- PWM period: PWM period in PWM clocks (base PWM clock in PoKeys devices is 25 MHZ) Author
that is shared ameng all PWM outputs - to set the 1 ms peried (1 kHzZ), set the value to
25000 Date
- Init period: If true, PoBlocks will initialize the PWM outputs with the specified PWM Autoreload pr... [] False
period value Project name
- Duty range: Maximum value of Duty input that equals to 100% pulse width Target device PoKeys57 series
- Default duty: Default value of the duty cycle (set on reset) "
- Show enable input: Set to True to display the Enable input B

Auto start [ False
Inputs: Reset core on ... True
- Duty (Integer): Duty cycle in the range from 0 to Duty range (block parameter) Disable di Fal
- Enable (Legic): Enable input. If 0, no write operation will be performed isable divisio... [] False
Cycle time i)
Outputs:
None
w
< >
Mouse: [489, 3] Not connected

7.5. Properties panel

Properties panel contains a dynamic grid of properties based on the currently selected object in the
diagram. By clicking on an empty space (without blocks), PoBlocks project properties are displayed in
the grid.

7.6. Project properties

Project properties are accessed by clicking on an empty space in the designing area (an area without
blocks or connections). The following options are available in the properties panel
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Reset core on startup: if checked, PolL core executes the

initialization code on PoKeys device startup (defining the pin
functions, setting-up the peripherals used in the diagram, etc.)

Auto start: if checked, PolL core starts PolL code execution
immediately after the PoKeys device is powered up

Cycle time: this option sets the cycle time, defining the time
between each diagram PollL code execution

Disable division by zero exception: if checked, division by zero
event does not stop PolL code execution, but generates result 0

Target device: a drop-box menu used to select the device type that
will be used to execute the diagram's code

General section: contains fields used for project documentation
purposes

8. Using PoBlocks

8.1. Inserting blocks

Shared data  Memory info
Property Value
Project properties
General
Author
Date

Auto reload pr... [] False
Project name
Target device PoKeys57 series
Auto start [ False
Reset core on ... True
Disable divisio... [_] False
Cycle time 10

Use left mouse button to drag a selected block from the block library to design area.

i poBlocks 2.0.0.0

;I’ [ﬁ E ‘ Check and Transfer

" poBlocks 2.0.0.0

L & B8

Chedk and Transfer

. . - File Edit View
File Edit View Tools Help

I

G & 0

Digital input

Digital input  Digi tput  Analoginput  PWI

Digital output

Tools Help

&

Analoginput  PW

Project

Project

Ca=d

Digital input

14
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8.2. Navigating the project diagram

The project diagram can be navigated via the scroll bars at the right and bottom and by using the
mouse. Use the scroll wheel to zoom in or out and drag with the right mouse button to move the
displayed view. Background grid helps in navigating the project.

8.3. Removing blocks

Select one block or use lasso selection to select multiple blocks, then press 'Delete’ button.

8.4. Moving blocks

Use left mouse button to move the selected block.

8.5. Copying blocks

Select the blocks you want to copy by a ‘lasso tool’. Press down the left mouse button on an empty part
of the diagram, then drag the mouse to select the blocks. To copy the blocks, press Ctrl+C or go to Edit >
Duplicate selected.

8.6. Connecting blocks

Right port of one block can only be connected to left port of another block. Left port of one block can
however be connected to either right port of another block or to an existing connection.

Start connecting the blocks by clicking on one of the empty ports (a port that can accept a connection
will be highlighted in green). You can then either drag the connection to another port and release the
mouse button or release the button immediately and click again on the destination block's port.

Digital input Digital output Digital input Digital output Digital input Digital output
1. Start at source port 2. Drag the connection 3. End at destination block

In order to route the connection around other blocks to improve the readability of the diagram,
intermediate points can be added to the connection. Just click on an empty space while dragging the
connection and an intermediate point will appear. Based on the connection profile, the connection will
pass the intermediate point in either vertical or horizontal direction. To move the intermediate point,
complete the connection, click on the intermediate point and drag it into the correct position.

Due to the properties of the block diagrams, left port (input) of each block can be connected to only one
right port (output) of another (or the same) block. However, each output can be connected to multiple
inputs. PoBlocks uses these rules and refuses a connection that breaks them.
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In order to connect multiple inputs (left ports) to one output (right port), simply use the existing output
port to start each connection.

Digital output —/-D|gna| output Digital output

Digital input Digital output 2 Digital input Digital output 2 Digital input Digital output 2
Cutput 4 Output 4

Digital output 3 Digital output 3 Digital output 3

Alternatively, link anchors can be used to split the connection to multiple inputs. Start by creating a base
connection between one input and one output. Then, start adding another connection by clicking on an
empty input and complete the connection by clicking on an existing connection.

Digital output Digital output Digital output Digital output
Digital input Digital output Digital input Digital output Digital input Digital output Digital input Digital output
Digital output Digital output Digital output Digital output

8.7.Constant inputs

Often a simple constant value is used as an input parameter. In order to insert a constant value, right
click on an empty input (left port) - constants can not be added to output (right ports). An default
constant value 0 appears - to edit the value, just click on it and enter a new value. To replace the
constant with a connection, simply drop the new connection to the port, containing the constant value -
the constant value will be replaced by the newly established connection.

8.8. Removing connections

In order to remove an existing connection, select the connection by clicking on it and press 'Delete’
button.

8.9. Configuring blocks

Basic blocks are configured using the properties panel on the right of the design area. Select a block first
and the properties panel will be automatically populated with options for that block. Help for each
property is included in the block help pop-up window in the block library.

Advanced (extended) blocks (those that have light blue background) like Event drum, Look-up table,
Schedule, LCD Ul, Custom PolL, etc. have a dedicated block properties editor. This editor is accessed by
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double-clicking on a block. The description of each of these blocks can be found in the blocks section
below.

8.10. Blocks grouping
PoBlocks supports blocks grouping to manage the diagram complexity.

To create a group of blocks, select the blocks that will form a group, as shown below.

= = Input Output |= =|FV Qut|= =|Input Output |se—— Tt QLU | — | = - IDuty l
Analog input 0 Hsp 50 [|Deadband a-{ - PWM output
PID Deadband 100 ©

=|A Product |=
2 B

Multiply

Co)s

Analog input

)

PWM output

-—.ﬁw = -_.1?%
\ 0 Usp 50 [{Deadband 0l
FID Deadband 100 ¢
RANI
~¥==lA Product
e

Multiply

Press ‘g’ on the keyboard to create a group — blocks will be moved into the group block.

Analog input Group PWM output

To access the group block contents, double-click the group block.

Note the navigation bar at the top changes in regards to the current view — when entering the group
block, the navigation will add the ‘/ Group block name’ to the current path, as shown below. Press
‘Escape’ on the keyboard to exit the group.
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Project { Group

-—1Group ouujutlll

|]-.|Group input) ==se==={Input Output |= : lpv Ot | lInput Output |=
0

Re-scale sk 50 [|Deadband
FID Deadband

=|A Product |=
2 0B

Multiply

Names of the group block object are derived from the ‘Group input’ and ‘Group output’ blocks. Use the
block property pane to change the position and the name of each input and output accordingly.

8.11. Importing group

PoBlocks also supports importing an existing PoBlocks project into the current diagram as a group by
selecting File > Import as group.
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9. Compile process

After PoBlocks diagram is finished, a built-in compiler is used to translate it into PolL code that is then
transferred and executed on a PoKeys device. During compiling, the diagram is checked for errors and if
any are detected, a pop-up error list window will appear and compiler process will be stopped. User has
to correct the errors before the diagram can be fully compiled and transferred to the PoKeys device.

Compile process executes the following operations

- The blocks are first put into a proper execution sequence based on their function and how they
are connected to other blocks. PolL core executes code of one block after the other and the
proper sequence is required to obtain correct result. If the diagram consists of algebraic loops
(closed loops containing blocks that can not be properly sectioned), an error is thrown and user
has to insert a proper '1 T delay' block somewhere in the loop in order to instruct the compiler
where to split the loop.

- After the block execution sequence is defined, PolL code is generated for each block.

- Code of all blocks is joined and optimized.

- Compile time errors (if any) are displayed in the errors pop-up window.

10.Modes of operation (Run, Stop)

When a PoKeys device is selected in the 'Device selection' dialog, an operating mode of the PolL core is
automatically displayed in device controls as a highlighted item.

STOP: PolL core is in STOPPED state, no PolL code is being
executed

Run: PolL core is running normally

Exception: PolL core encountered an exception and had to

be stopped. For more info on the cause of the exception,
click the red Exception button.
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11.Exceptions

The following figure displays a 'Division by zero' exception description after clicking the 'Exception' mode
button in the device controls. The dialog also displays the most probable block that caused the
exception.

¥ PoBlocks 2.0.0.0 [F/Projekti/PoKeys/.../PoBlocks/group0.xml]

|_—; i BY | checkandTransfer & @ L Reset | )

File Is Help

Edit View Tao

UOB Mlgebra  Logic  Memory  Trigger /tming  Extended  Control Commuriica lick

nr J*" ~ nr ot
nr my
o Ii'l . Ii‘l el ‘ﬁ' r h Sensor
Digital input  Digital output  Analoginput  PWM output  PWM output C  Encoder value Digital counter  EasySensors B
<
Project f Group
A~
Divide & Exception X
0 0a A/Bp]
PolL core encountered an exception:
0 qe J Block 'Divide': Division by zero
Divide
v
< >
Mouse: [333, 10] Connected to Pokeys57CNC [21000]

12.Monitor mode

PoBlocks features a ‘Monitor mode’ that is used to observe the PoBlocks diagram execution on the
device in nearly real-time. Monitor mode can be enabled after the diagram is compiled and transferred
to the device using the ‘Monitor mode’ toggle switch in device controls section. Once activated, no
changes to the diagram are allowed until the monitor mode is deactivated.

All output ports of blocks in the diagram are equipped with the output value display that extend over
the connection to the other block. Connections that carry Boolean signals (On/Off, True/False) are
colored in gray (inactive = Off, False) or in light green (active = On, True), giving user a visual feedback of
the diagram state.
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13.Task manager

PoBlocks features task manager feature that gives the user an insight into how the PolL code is being
executed. Task manager can be accessed when the connection with PoKeys device is established by
clicking on Tools > Task manger.

¥ PolL task manager ? *

Task Load Status Target cycle time  Real cycle time
1 Inactive 100 %
2 Task0D 0% Running
3 Task1 0% Running 10 ms 16% ms

Task manager shows all tasks that are currently being executed and the basic information on tasks’
performances.

‘Inactive’ task shows how much ‘Load’ is still available to tasks (unused processing time)

Task 0 is the primary task being executed by PoKeys device. In periodic mode this task is only used to
initialize and start other tasks and does not affect the operation afterwards, while in non-periodic mode,
only task 0 is used for code execution.

Last two columns show the ‘Target cycle time’ (set in the project settings) and ‘Real cycle time’
(true/real cycle time managed by the device).

14.Shared data

In order to share data between PolL code and other PoKeys systems (Web dashboard and Modbus
interface on Ethernet PoKeys devices, third-party applications on other devices or computers, connected
to PoKeys, etc.) a shared data slots were introduced in PoKeys devices with PolL core support. Each
Shared data slot can hold 1-, 8-, 16- or 32-bit data, which can be read or written by any of the involved
systems. Most frequently, PolL code writes to Shared data slot in order to allow other systems (e.g.
PoKeys Dashboard or Modbus device) or reads from Shared data slot in order to obtain data from other
systems (e.g. user interaction via Dashboard or Modbus device operation).

14.1. Writing data to Shared data slot

In order to write data to shared data slot, switch to ‘Shared data’ tab in the properties section and
double-click on an empty slot to start the slot assignment process (figure below). A circular selection will
appear in the design area, instructing you to select an output port to share.
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W PoBlocks 2.0.0.0 [Fy/Projekti/PoKeys/.../PoBlocks/group0.xmi] - O x

N&B ‘ Check and Transfer & B P rest [ )

File  Edit View Tools Help

LN Algebra  Logic  Memory  Trigger /tming  Extended Control  Communication  Misc

nr nr ~ o ey

- L
© I'I'l [} =iy =3 o Xh Vemer e vz e
PoExtBus

Digitalinput  Digital output ~ Analoginput ~ PWMoutput  PWM output ¢ Encoder value  Digital counter  EasySensors P:E’“ﬂ'f =

<

et r | Double-click

<

<--- Select the output port

2: <no port selected>
3: <no port selected>
4 <no port selected>
Digtal input, 5: <no port selected>
(réiue 1) OSekmutputpnrt to shere 5 <no pot selected
Digital input 7: <no port selected>
8: <no port selected>
9: <no port selected>
10: <no port selected>
11: <no port selected>
12: <no port selected>
13: <no port selected>
14: <no port selected>
15: <no port selected>
16: <no port selected>
17: <no port selected>
18: <no port selected>
18: <no port selected>
20: <no port selected>
w | [21: <no port selected>
< > 22: <no port selected> v

Mouse: [269, 118] Connected to Pokeys57CNC [21000]

Move the cursor over to the port you want to share and click on it — this will complete the assignment
process for that shared data slot. A shared port will be highlighted in yellow with the text showing ‘Sx’
(where x is the Shared data slot ID).

PoExtBus PoExtBus

Encoder value Digital counter  EasySensors Toma e

Shared data

Digital input -> Value 1 ~
<no port selected>
<no port selected>

Digital input BN

y <no port selected>
Digital input

<no port selected>
<no port selected>
<no port selected>
<no port selected>

S PR

PR ER YR

Shared slot ID (displayed as a shared slot index in the list and on every port with shared slot assigned to)
is used to refer to this slot from other systems.

Certain memory objects (data latch, min/max value memory, etc.) can be used to read and write shared
data slots. When a latch clock signal (for data latch) or lower/higher input value is detected, a shared
data slot value is updated with a new value. If other systems write to the same shared data slot, this
new value is used in PolL code also.

14.2. Reading data from shared data slots

Use on of the ‘Shared x-bit’ blocks (where x is 1, 8, 16 or 32) from the block library under the ‘Misc’
category. Shared data slot must then be assigned to the output port of that block (figure below
illustrates a Shared 16-bit block without and with a shared data slot assigned.
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Shared 16-bit _
(Sarea o) (55

14.3. Monitoring and changing of shared data slots

In order to see the values of shared data slots and/or to change it, open the Shared data slot manager
(to open it, go to ‘Tools > Shared slot manager’ menu).

" Shared data slot manager ? X

Slot number Value

Slot 1
Slot 2
Slot 3
Slot 4
Slot 5
Slot &
Slot 7
Slot 8
10 Slot9
11 Slot 10
12 Slet M
13 Slot 12

[ = = = I

[—=RE—-NE—-RN - RN R R~ — R )

15. PoBlocks data types

In general, PoBlocks supports Boolean values (1-bit) and signed integer numbers (8-, 16- or 32-bit).
While most of blocks use predefined data types for inputs and outputs, PoBlocks compiler converts
between the types automatically without user intervention. Support for floating point arithmetic is not
implemented, fix point arithmetic has to be used instead by the user (e.g. to obtain 0.01 resolution, all
calculations must be done with numbers greater for a factor of 100, only divided or modulated by 100
when displaying the values to the user).
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16.Blocks description

16.1.

Description
Inputs
Outputs
Properties

Remarks

16.2.

Description

Inputs

Outputs
Properties

Remarks

16.3.

Description
Inputs
Outputs

Properties

Remarks

|O - Digital input

Digital input is used to read the state of the digital input on PoKeys device

None

Value (Logic): Digital input state

Pin ID (Integer, 1 to 55): PoKeys pin ID as indicated on the device

Init function (Logic): If true, PoBlocks will setup the selected pin as digital input on
startup

Inverted (Logic): If true, pin state will be inverted

None

|0 - Digital output

Digital output is used to set the state of the digital output on PoKeys device
Output (Logic): Digital output state
Enable (Logic): Enable input. If 0, no write to output will be performed

None
Pin ID (Integer, 1 to 55): PoKeys pin ID as indicated on the device

Init function (Logic): If true, PoBlocks will setup the selected pin as digital input on
startup
Inverted (Logic): If true, pin state will be inverted

Default value (Logic): The default state of the output on reset (True=1, False=0)

Set to default on init (Logic): If true, the value of the output is set to Default value on
reset
Show enable input (Logic): Set to True to display the Enable input

None

|O - Analog input

Analog input is used to read one analog input value on PoKeys device

None

Value (16-bit integer): Analog input value (0 to 4095)

Pin ID (Integer, 41 to 47): PoKeys pin ID as indicated on the device

Init function (Logic): If true, PoBlocks will setup the selected pin as digital input on
startup

Output value (Other type): Output value type selection

None
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Description

Inputs

Outputs
Properties

Remarks

Description

Inputs

Outputs
Properties

Remarks

Description
Inputs
Outputs
Properties

PWM output is used to set the duty cycle of the PWM (pulse width modulated)
output

Duty (32-bit integer): Duty cycle in the range from 0 to Duty range (block parameter)
Enable (Logic): Enable input. If 0, no write operation will be performed

None

Pin ID (Integer, 17 to 22): PoKeys pin ID as indicated on the device

PWM period (Integer): PWM period in PWM clocks (base PWM clock in PoKeys
devices is 25 MHz) that is shared among all PWM outputs - to set the 1 ms period (1
kHz), set the value to 25000

Init period (Logic): If true, PoBlocks will initialize the PWM outputs with the specified
PWM period value

Duty range (Integer): Maximum value of Duty input that equals to 100% pulse width
Default duty (Integer): Default value of the duty cycle (set on reset)

Show enable input (Logic): Set to True to display the Enable input

None

PWM output Cis used to set the duty cycle and period of the PWM (pulse width
modulated) outputs. PWM outputs 1 to 6 equate to pins 17 to 22 on PoKeys56E/U.
Warning: pulse width anomalies can occur when changing PWM period.

Period (32-bit integer): PWM period in PWM clocks (base PWM clock in PoKeys
devices is 25 MHz) that is shared among all PWM outputs - to set the 1 ms period (1
kHz), set the value to 25000

Update period (Logic): Update input. On rising edge, PWM period will be updated
Duty 1-6 (32-bit integer): Duty cycle for PWM output 1-6 in percent

Enable (Logic): Enable input. If 0, no write operation will be performed

None

Default period (Integer): Default PWM period (set on reset)

Show enable input (Logic): Set to True to display the Enable input

Default duty 1-6 (Integer): Default value of the duty cycle in percent

None

Encoder value reads the value of the encoder counter

None

Encoder (32-bit integer): Encoder counter value

Encoder ID (Integer, 1 to 26): PoKeys encoder ID (0 to 25)

Channel A pin (Integer, 1 to 55): PoKeys pin ID as indicated on the device, used for
encoder A channel signal
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Channel B pin (Integer, 1 to 55): PoKeys pin ID as indicated on the device, used for
encoder B channel signal
Multiplier 4x (Logic): Activate the 4x multiplier for encoder signals - encoder counter
is incremented on any change of the A or B signals
Init encoder (Logic): If true, PoBlocks will initialize the encoder with the specified
settings on startup
Clear on start (Logic): If true, encoder counter will be reset on startup
Show reset input (Logic): If true, reset input is displayed

Remarks None

16.7. |O - Digital counter

Description Digital counter reads the value of the digital counter. Digital counter enables
counting signals of higher frequencies
Inputs None
Outputs Value (32-bit integer): Digital counter value
Properties Counter pin (Integer, 1 to 55): PoKeys pin ID as indicated on the device, used as
digital counter input. Not all pins support digital counters - advise PoKeys manual
Use direction pin (Logic): If True, pin specified by Direction pin is used to define the
count direction
Direction pin (Integer, 1 to 55): PoKeys pin ID as indicated on the device, used as
digital counter direction input
Rising edge (Logic): If true, counter will be incremented on rising signal edges
Falling edge (Logic): If true, counter will be incremented on falling signal edges
Clear on start (Logic): If true, counter will be reset on startup
Show reset input (Logic): If true, reset input is displayed
Remarks None

16.8. IO - Sensor value

Description Sensor value outputs the current value of the selected sensor

Inputs None
Outputs Value (32-bit integer): Sensor value
Sensor OK (Logic): Sensor status - 0 if sensor is inactive or error occured

Properties Sensor ID (Integer, 1 to 27): PoKeys sensor ID as configured in PoKeys configuration -
12C sensors have IDs between 1 and 10, 1-wire sensors have IDs between 11 and 20,
analog sensors have IDs between 21 and 27.
Remarks None
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16.9.

Description
Inputs

Outputs
Properties

Remarks

16.10.

Description
Inputs

Outputs
Properties

Remarks

16.11.

Description
Inputs
Outputs

Properties
Remarks

16.12.

Description
Inputs

|O - PoExtBus output

PoExtBus output sets the state of one output on PoExtBus module

Output (Logic): Output state

Enable (Logic): Enable input. If 0, no write operation will be performed

None

Module number (Integer, 1 to 10): PoExtBus module ID (1-10)

Module output (Integer, 1 to 8): PoExtBus output ID (1-8)

Default value (Logic): The default state of the output on reset (True=1, False=0)

Set to default on init (Logic): If true, the value of the output is set to Default value on
reset

Show enable input (Logic): Set to True to display the Enable input

None

IO - PoExtBus module

PoExtBus module sets the state of 8 PoExtBus outputs on selected PoExtBus module
Output 1-8 (Logic): Output state

Enable (Logic): Enable input. If 0, no write operation will be performed

None

Module number (Integer, 1 to 10): PoExtBus module ID (1-10)

Set to default on init (Logic): If true, the value of the output is set to Default value on
reset

Output 1-8 default (Logic): The default state of the output on reset (True=1, False=0)
Show enable input (Logic): Set to True to display the Enable input

None

IO - Pulse engine status

Pulse engine status - current position of the pulse engine
None

X (32-bit integer): x axis

y (32-bit integer): y axis

Z (32-bit integer): z axis

None

Algebra - Sum

Sum of inputs
A (32-bit integer): First variable A
B (32-bit integer): Second variable B
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C (32-bit integer): Third variable C
D (32-bit integer): Forth variable D

Outputs Sum (32-bit integer): Sum of Aand B

Properties Inputs (Integer, 2 to 4): Number of inputs
Remarks None

16.13.

Description
Inputs

Outputs
Properties
Remarks

16.14.

Description
Inputs

Outputs
Properties
Remarks

Algebra - Subtract

Difference of two inputs

A (32-bit integer): First variable A

B (32-bit integer): Second variable B

A - B (32-bit integer): Difference of A and B (A - B)
None

None

Algebra - Multiply

Product of inputs

A (32-bit integer): First variable A

B (32-bit integer): Second variable B

C (32-bit integer): Third variable C

D (32-bit integer): Forth variable D
Product (32-bit integer): Product of inputs

Inputs (Integer, 2 to 4): Number of inputs
None

16.15.  Algebra - Divide

Description
Inputs

Outputs
Properties
Remarks

Division of two inputs

A (32-bit integer): First variable A

B (32-bit integer): Second variable B

A / B (32-bit integer): Division result of A and B (A / B)

None

Division by zero triggers a Division by zero exception in PolL core. To stop this from
happening, 'Disable division by zero exception' must be enabled in project properties

16.16.  Algebra - Modulo

Description Modulo operation of two inputs
Inputs A (32-bit integer): First variable A

B (32-bit integer): Second variable B

Outputs A mod B (32-bit integer): Modulo operation result (A modulo B)
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Properties None
Remarks None
16.17.  Algebra - Abs
Description Absolute value of the input signal
Inputs Input (32-bit integer): Input variable
Outputs Output (32-bit integer): Absolute value of the input variable
Properties None
Remarks None
16.18.  Algebra - Min
Description Min Minimum of inputs
Inputs A (32-bit integer): First variable A
B (32-bit integer): Second variable B
C (32-bit integer): Third variable C
D (32-bit integer): Forth variable D
Outputs Min (32-bit integer): Minimum value of inputs
Properties Inputs (Integer, 2 to 4): Number of inputs
Remarks None
16.19.  Algebra - Max
Description Max Maximum of inputs
Inputs A (32-bit integer): First variable A
B (32-bit integer): Second variable B
C (32-bit integer): Third variable C
D (32-bit integer): Forth variable D
Outputs Max (32-bit integer): Maximum value of inputs
Properties Inputs (Integer, 2 to 4): Number of inputs
Remarks None
16.20. Logic - NOT
Description NOT : negation logic
Inputs Input (Logic): Input signal
Outputs !Input (Logic): Negated input signal
Properties None
Remarks None
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16.21.

Description
Inputs

Outputs
Properties

Remarks

16.22.

Description
Inputs

Outputs
Properties

Remarks

16.23.

Description
Inputs

Outputs

Properties
Remarks

16.24.

Description
Inputs

Logic - AND

AND : logical AND operation

A (Logic): A signal input

B (Logic): B signal input

C (Logic): C signal input

D (Logic): D signal input

AND (Logic): Result of logical AND operation on input signals

NAND (Logic): Negated result of logical AND operation

Show negated output (Logic): Set to True to display the NAND output
Inputs (Integer, 2 to 4): Number of logical inputs

None

Logic - OR

OR : logical OR operation

A (Logic): A signal input

B (Logic): B signal input

C (Logic): C signal input

D (Logic): D signal input

OR (Logic): Result of logical OR operation on input signals

NOR (Logic): Negated result of logical OR operation

Show negated output (Logic): Set to True to display the NOR output
Inputs (Integer, 2 to 4): Number of logical inputs

None

_— O ~— ~—

Logic - XOR

XOR : logical XOR operation

A (Logic): A signal input

B (Logic): B signal input

XOR (Logic): Result of logical XOR operation on input signals

EQ (Logic): Negated result of logical XOR operation

Show negated output (Logic): Set to True to display the EQ output
None

Logic - Compare (GT)

Compare (GT) checks whether Value is greater than Reference
Value (32-bit integer): Input signal
Reference (32-bit integer): Reference signal

Outputs Result (Logic): Result of comparison - 1 if condition is met, 0 otherwise
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IResult (Logic): Negated result of the comparison

Properties Show negated output (Logic): Set to True to display the negated result output
Remarks None

16.25.

Description
Inputs

Outputs

Properties
Remarks

16.26.

Description
Inputs

Outputs

Properties
Remarks

16.27.

Description
Inputs

Outputs

Properties
Remarks

16.28.

Description
Inputs

Outputs

Properties

Logic - Compare (GE)

Compare (GE) checks whether Value is greater than or equal to Reference
Value (32-bit integer): Input signal

Reference (32-bit integer): Reference signal

Result (Logic): Result of comparison - 1 if condition is met, 0 otherwise
IResult (Logic): Negated result of the comparison

Show negated output (Logic): Set to True to display the negated result output
None

Logic - Compare (EQ)

Compare (EQ) checks whether Value is equal to Reference

Value (32-bit integer): Input signal

Reference (32-bit integer): Reference signal

Result (Logic): Result of comparison - 1 if condition is met, 0 otherwise
IResult (Logic): Negated result of the comparison

Show negated output (Logic): Set to True to display the negated result output
None

Logic - Compare (LE)

Compare (LE) checks whether Value is lower than or equal to Reference
Value (32-bit integer): Input signal

Reference (32-bit integer): Reference signal

Result (Logic): Result of comparison - 1 if condition is met, 0 otherwise
IResult (Logic): Negated result of the comparison

Show negated output (Logic): Set to True to display the negated result output
None

Logic - Compare (LT)

Compare (LT) checks whether Value is lower than Reference

Value (32-bit integer): Input signal

Reference (32-bit integer): Reference signal

Result (Logic): Result of comparison - 1 if condition is met, 0 otherwise
IResult (Logic): Negated result of the comparison

Show negated output (Logic): Set to True to display the negated result output
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Remarks None

16.29.

Description
Inputs

Outputs

Properties
Remarks

16.30.

Description
Inputs

Outputs
Properties

Remarks

16.31.

Description
Inputs

Outputs
Properties

Remarks

16.32.

Description
Inputs

Logic - Compare (NE)

Compare (NE) checks whether Value is not equal to Reference

Value (32-bit integer): Input signal

Reference (32-bit integer): Reference signal

Result (Logic): Result of comparison - 1 if condition is met, 0 otherwise
IResult (Logic): Negated result of the comparison

Show negated output (Logic): Set to True to display the negated result output
None

Memory - Set/Reset latch

Set/Reset latch simulates an (asynchronous) SR (Set/Reset) latch

S (Logic): Set input signal

R (Logic): Reset input signal

Q (Logic): Latch state

Default value (Logic): Default value on reset

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.

Initial value (Logic): The initial value of the retained block after it gets uploaded to
the device.

None

Memory - JK latch

JK latch simulates an (asynchronous) JK latch

J (Logic): J input signal

K (Logic): K input signal

Q (Logic): Latch state

Default value (Logic): Default value on reset

Retain on reset (Logic): If True, the value is saved to battery-backed RAM.

Initial value (Logic): The initial value of the retained block after it gets uploaded to
the device.

None

Memory - D latch

D latch simulates an (asynchronous) D latch
D (Logic): D input signal
E (Logic): E(nable) input signal
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Outputs Q (Logic): Latch state
Properties Default value (Logic): Default value on reset

Remarks

16.33.

Description
Inputs

Outputs
Properties

Remarks

16.34.

Description
Inputs

Outputs
Properties

Remarks

16.35.

Description
Inputs

Outputs
Properties

Remarks

Retain on reset (Logic): If True, the value is saved to battery-backed RAM.

Initial value (Logic): The initial value of the retained block after it gets uploaded to
the device.

None

Memory - JK flip-flop

JK flip-flop simulates a JK flip-flop

J (Logic): J input signal

CLK (Logic): Clock input signal

K (Logic): K input signal

Q (Logic): Flip-flop state

Default value (Logic): Default value on reset

Retain on reset (Logic): If True, the value is saved to battery-backed RAM.

Initial value (Logic): The initial value of the retained block after it gets uploaded to
the device.

None

Memory - D flip-flop

D flip-flop simulates a D flip-flop

D (Logic): D input signal

CLK (Logic): Clock input signal

Q (Logic): Flip-flop state

Default value (Logic): Default value on reset

Retain on reset (Logic): If True, the value is saved to battery-backed RAM.

Initial value (Logic): The initial value of the retained block after it gets uploaded to
the device.

None

Memory - T flip-flop

T flip-flop simulates a T flip-flop

T (Logic): T input signal

CLK (Logic): Clock input signal

Q (Logic): Flip-flop state

Default value (Logic): Default value on reset

Retain on reset (Logic): If True, the value is saved to battery-backed RAM.

Initial value (Logic): The initial value of the retained block after it gets uploaded to
the device.

None
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16.36.

Description
Inputs
Outputs

Properties

Remarks

16.37.

Description
Inputs
Outputs
Properties
Remarks

16.38.

Description
Inputs

Outputs
Properties

Remarks

Memory - Data latch

Data latch simulates a data latch. Similar to D flip-flop, but supports integers for input
(D flip-flop uses logical signals only)

Data in (32-bit integer): Integer data input

CLK (Logic): Clock input signal

Value (32-bit integer): Stored integer data

Value F (32-bit integer): Stored integer data (on falling edge) in bi-directional mode
Default value (Integer): Default reset value

Bi-directional (Logic): If True, the latch samples on both the rising edge and falling
edge.

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.

Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.

None

Memory - 1 T delay

1 T delay simulates a one-cycle delay

In (32-bit integer): Integer data input

Q (32-bit integer): Integer data output
Default value (Integer): Default reset value
None

Memory - MIN memory

MIN memory remembers the minimum value of the Data in signal. Use CLK input to
reset the memory.

Data in (32-bit integer): Integer data input

CLK (Logic): Clock input signal

Value (32-bit integer): Stored minimum value

Default value (Integer): Default reset value

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disabled default value setting.

Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.

None
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16.39.

Description
Inputs

Outputs
Properties

Remarks

16.40.

Description
Inputs

Outputs
Properties

Remarks

16.41.

Description
Inputs

Outputs
Properties

Memory - MAX memory

MAX memory remembers the maximum value of the Data in signal. Use CLK input to
reset the memory.

Data in (32-bit integer): Integer data input

CLK (Logic): Clock input signal

Value (32-bit integer): Stored maximum value

Default value (Integer): Default reset value

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disabled default value setting.

Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.

None

Memory - RAM (8-bit)

RAM (8-bit)

Data (8-bit integer): Integer data input

Address store (16-bit integer): Address of the destination memory

CLK store (Logic): Clock input signal for storing data

Address load (16-bit integer): Address of the destination memory

CLK load (Logic): Clock input signal for retrieving data

Data out (8-bit integer): Stored integer data (on falling edge) in bi-directional mode
Memory size (Integer, 1 to 255): Number of memory cells

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.

Initial value (Integer, 0 to 255): The initial value of the retained block after it gets
uploaded to the device.

Initial RAM value (Integer, 0 to 255): The initial value of the retained block after it
gets uploaded to the device.

None

Memory - RAM (16-bit)

RAM (16-bit)

Data (16-bit integer): Integer data input

Address store (16-bit integer): Address of the destination memory

CLK store (Logic): Clock input signal for storing data

Address load (16-bit integer): Address of the destination memory

CLK load (Logic): Clock input signal for retrieving data

Data out (16-bit integer): Stored integer data (on falling edge) in bi-directional mode
Memory size (Integer, 1 to 255): Number of memory cells

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.
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Initial value (Integer, 0 to 65535): The initial value of the retained block after it gets
uploaded to the device.
Initial RAM value (Integer, 0 to 65535): The initial value of the retained block after it
gets uploaded to the device.

Remarks None

16.42. Memory - RAM (32-bit)

Description RAM (32-bit)
Inputs Data (32-bit integer): Integer data input

Address store (16-bit integer): Address of the destination memory
CLK store (Logic): Clock input signal for storing data
Address load (16-bit integer): Address of the destination memory
CLK load (Logic): Clock input signal for retrieving data

Outputs Data (32-bit integer): Stored integer data (on falling edge) in bi-directional mode

Properties Memory size (Integer, 1 to 255): Number of memory cells

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.
Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.
Initial RAM value (Integer): The initial value of the retained block after it gets
uploaded to the device.

Remarks None

16.43.  Memory - Sample/hold

Description Sample/hold simulates a sample and hold element. When the sample input is
enabled, the block operates in transparent mode. When sample input is disabled, the
output retains the last value.

Inputs Data in (32-bit integer): Integer data input
Sample (Logic): Sample input signal
Outputs Value (32-bit integer): Stored integer data
Properties Default value (Integer): Default reset value
Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.
Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.
Remarks None
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16.44.

Description
Inputs
Outputs
Properties

Remarks

16.45.

Description
Inputs
Outputs

Properties
Remarks

16.46.

Description
Inputs
Outputs

Properties
Remarks

16.47.

Description

Inputs

Outputs

Properties

Trigger / timing - Clock source

Clock source

Half time-period (32-bit integer): Dynamic Half time-period optional input
Clock (Logic):

Half time-period (Integer, 1 to 3600000): Half of the clock time period (in
milliseconds - set to 500 for 1 Hz clock)

Show dynamic input (Logic): If set to True, Half-time period input is enabled
None

Trigger / timing - Rising edge

Rising edge triggers the output when the Input signal value changes from 0 to 1
(rises)

Input (Logic): Input signal

Change (Logic): Output indicating a change in the input signal

None

None

Trigger / timing - Falling edge

Falling edge triggers the output when the Input signal value changes from 1to 0
(falls)

Input (Logic): Input signal

Change (Logic): Output indicating a change in the input signal

None

None

Trigger / timing - Up counter

Up counter counts the Clock input positive (rising) changes from 0 to value, specified
by PV input

Clock (Logic): Counter pulse signal

Reset (Logic): When 1, resets the counter value Value to 0

PV (32-bit integer): Maximum counter value

Q (Logic): Indicates whether counter has reached maximum value

Value (32-bit integer): Current counter value

Default value (Integer): Default reset value of the counter

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.

Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.
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Remarks None

16.48. Trigger / timing - Down counter

Description Down counter decrements the counter on the Clock input positive (rising) changes
from value, specified by PV input, to 0
Inputs Clock (Logic): Counter pulse signal

Load PV (Logic): When 1, counter value Value is loaded with value of PV
PV (32-bit integer): Initial counter value

Outputs Q (Logic): Indicates whether counter has reached 0
Value (32-bit integer): Current counter value

Properties Default value (Integer): Default reset value of the counter

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.
Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.

Remarks None

16.49.  Trigger / timing - Up/down counter

Description Up/down counter increments the counter vaue on the Clock up input positive (rising)
changes and decrements the counter on the Clock down input positive (rising)
changes. The counter value Value is limited to the range between (including) 0 to PV

Inputs Clock up (Logic): Counter increasing pulse signal

Clock down (Logic): Counter decreasing pulse signal
Reset (Logic): When 1, resets the counter value Value to 0
Load PV (Logic): When 1, counter value Value is loaded with value of PV
PV (32-bit integer): Initial/maximum counter value

Outputs QU (Logic): Indicates whether counter has reached maximum value
QD (Logic): Indicates whether counter has reached 0
Value (32-bit integer): Current counter value

Properties Default value (Integer): Default reset value of the counter

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.
Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.

Remarks None

16.50.  Trigger / timing - Pulse timer

Description
Pulse timer triggers on IN high input signal and turns off after the period defined by

PT, uneffected by the IN signal state during this period as illustrated below
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Inputs
Outputs

Properties
Remarks

16.51.

Description

Inputs
Outputs

Properties
Remarks

16.52.

Description

Inputs
Outputs

Properties
Remarks

IN (Logic): Timer activation signal input

PT (32-bit integer): Timer period signal input (in ms)
Q (Logic): Timer activation status signal

ET (32-bit integer): Timer current time signal (in ms)
None

WL

of L T L

Trigger / timing - On timer

On timer or (on delay timer) starts counting time on IN input signal rising edge and
turns on after the period defined by PT. The timer is reset if the input signal IN goes
to low state as illustrated below

IN (Logic): Timer activation signal input
PT (32-bit integer): Timer period signal input (in ms)
Q (Logic): Timer activation status signal
ET (32-bit integer): Timer current time signal (in ms)

|qu€7 [

ﬂ -FI'I

pil |

Trigger / timing - Off timer

Off timer or (off delay timer) activates on IN high input signal state. The timer starts
counting on the IN input signal falling edge and turns off after the period defined by
PT. The counter is reset if the input signal IN goes to high state and the timer stays
activated as illustrated below

IN (Logic): Timer activation signal input

PT (32-bit integer): Timer period signal input (in ms)

Q (Logic): Timer activation status signal

ET (32-bit integer): Timer current time signal (in ms)

None

I
F1

1

Q

i
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16.53.

Description
Inputs
Outputs

Properties
Remarks

16.54.

Description

Inputs

Outputs
Properties
Remarks

Trigger / timing - Time

Time is used to read current date and time
None

Second (8-bit integer): Seconds

Minute (8-bit integer): Minute

Hour (8-bit integer): Hour

Day of month (8-bit integer): Day of month
Month (8-bit integer): Month

Year (16-bit integer): Year

Day of week (8-bit integer): Day of week
None

None

Extended - Event drum

Event drum resembles a mechanical contact drum and enables easy-to-use
programming of various output sequences. Double-click on block to edit

configuration.

Position (32-bit integer): Drum position input (in the range from 0 to number of

entries - 1)
Out 1-8 (Logic): Drum output 1-8 signal
None

Event drum editor (see figure below) is used to define outputs at each drum slot.
Left-click to toggle output (Green = activated) and use check boxes on the left to set

the number of slots on the drum.
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16.55. Extended - Look-up table (byte)

Description Look-up table (byte) is used to select data from the table. Double-click on block to
edit configuration.
Inputs Position (32-bit integer): Look-up table entry index
Outputs Out (8-bit integer): Entry value
Properties None
Remarks Use look-up table editor to set values of the entries. Use check boxes on the left to
set number of entries in the table.

Enable look-up table entries and set values

16.56. Extended - Schedule

Description Schedule is used to setup activation schedule by configuring multiple intervals. To
setup the intervals, double click on the block in the scheme.
Inputs None
Outputs Out (8-bit integer): Activation signal
Out 1 - 10 (8-bit integer): Interval-specific optional ouputs.
Rule 1 - 10 (32-bit integer): interval-specific optional rule access, that can be used to
access and modify rule data using shared slots.
Properties Separate outputs (Logic): When enabled, each interval rule drives its own output,
Out is still the OR-ed value of all.
Expose rules values (Logic): When enabled, each interval rule is connected to the
output, allowing remote changes to the intervals.
Rules (Integer, 1 to 10): Number of scheduler rules
Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.
Remarks Use schedule editor to configure the time-based output activation rules. Up to 10
rules can be defined for a single Schedule block a slider-based interface. Double-click
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the Schedule block to access the editor. Each rule defines one time interval during
which the output is activated. Use left mouse button to drag the ON and OFF sliders
to appropriate positions and select weekdays that the rule is valid on. If OFF slider is
positioned to the left of the ON slider, ON slider time refers to the time in the next
day.

By default, 2 rules are available for setup (to increase the number of rules, change
the 'Rules' property of the block).

With separate outputs option set to 'False’, the block outputs single value, based on
the On/Off values, defined in the Schedule block editor (in upper-right corner).

7] Schedule editor i S
0 alue
0 2 3 4 5 6 7 8 9 101112 13 14 15 16 17 18 19 20 21 22 23 24
Interval 1 | NS S IS I [ S S S S B S S S S —S— S— S— — — Mo Tu EHE Su

01 2 3 4 5 & 7 8 9 1011 12 13 14 15 16 17 18 19 20 21 22 23 24
Interval 2 [ e e T S S S S ST NSy N m We Th Fr Sa H

Drag the On/Off time sli

If separate outputs option is enabled (set to 'True'), the Schedule block outputs
separate values for each defined rule with their respective On and Off values, set in
the fields on the right side of the dialog. The 'Out' output outputs a logical 1/0 value,
indicating whether any of the rules is active or not.

[Z Schedule editor - EE

On e |
0 2 3 45 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 13 24
Interval 1 0 0% 1103 0 000 eessseessessssssses 0 Mo Tu We Th Fr EE m
On f Off value
0 2 3 4 5 6 7 8 9 1011 12 13 14 15 16 17 18 19 20 21 22 23 24
wen 1111106 Zscpupprpsvyysnzey MMM MO

Drag the On/Off sliders w set time inverval

In order to allow remote schedule modification, 'Expose rules values' option is
available. Additional rules outputs appear on the block, which can be connected to
Shared data slots. The rule is bit-wise encoded in a 32-bit value as described in the
list below:

Bits 0-5: onMinute

Bits 6-10: onHour

Bits 11-16: offMinute

Bits 17-21: offHour

Bits 22-28: bit-encoded week days

Bits 29-31: unused

O O O O O O

16.57. Extended - Multiplexer n-1

Description Multiplexer n-1 routes an input, specified by the SEL input, to output. Unconnected
input will be resolved as 0.
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Inputs

Outputs
Properties
Remarks

16.58.

Description
Inputs

Outputs
Properties
Remarks

16.59.

Description
Inputs

Outputs
Properties
Remarks

16.60.

Description
Inputs
Outputs
Properties

Remarks

16.61.

Description

SEL (8-bit integer): SEL

In 1-10 (32-bit integer): Input 1-10

Out (32-bit integer): Value of the selected input
Inputs (Integer, 2 to 10): Number of inputs
None

Extended - Deadband

Deadband adds symetrical deadband effect to the input signal.
Input (32-bit integer): Input signal

Deadband (32-bit integer): (Half-)deadband width

Output (32-bit integer): Signal with deadband

None

None

Extended - Limit

Limit adds limit effect to the input signal.

Input (32-bit integer): Input signal

Out min (32-bit integer): Minimum output signal value
Out max (32-bit integer): Maximum output signal value
Output (32-bit integer): Limited signal

None

None

Extended - Re-scale

Re-scale rescales the input signal using the specified ranges
Input (32-bit integer): Input signal

Output (32-bit integer): Rescaled signal

Input min (Integer): Minimum value of the input signal

Input max (Integer): Maximum value of the input signal

Output min (Integer): Output signal at the minimum input signal
Output max (Integer): Output signal at the maximum input signal
Limit output (Logic): Limit output to the specified range

None

Extended - LCD Ul

LCD Ul is used to configure user interface on alphanumeric LCD. LCD Ul supports
multiple LCD layouts (LCD contents), which can be selected/switched using the
'Layout' input. Each layout can contain different static (text) and dynamic (block
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Inputs

Outputs
Properties

Remarks

output values) content.

LCD Ul block must be stimulated on the refresh input in order to refresh the contents
of the LCD. LCD refresh is a time-consuming operation and is not done by PoBlocks or
PolL code by itself — user has to define a proper refresh time using clock signal block
or generate a signal to refresh the LCD otherwise.

Double-click on block to edit configuration.

Layout (Logic): Layout selection input

Refresh (Logic): Refresh input. LCD interface will be refreshed on low-to-high
transition

None

Use secondary pins (Logic): If True, LCD will be initialized on secondary pins as
described in PoKeys manual

LCD rows (Integer, 1 to 4): Number of rows in the LCD display

LCD columns (Integer, 1 to 20): Number of columns in the LCD display

LCD Ul editor is split into layouts list on the left and a current layout editor on the
right. Start by adding a new layout using 'Add new' button on the bottom. Select the
new layout and place static or dynamic contents to LCD.

To place static contents (text), click on the position on the LCD simulator and enter
the text. To navigate with keyboard, use arrow keys.

Dizlog

LCD layouts: I
Layout 0

This is one
layout[]

Block [LCD UL Port|IN: Layout

addnew | [ pelte || Add variable

Dynamic content is placed using the 'Add variable' button on the bottom. Move
cursor to the position where you want to position the dynamic contents and press
'Add variable'. A grey rounded rectagle will appear — click on it to edit the display
properties, use the 'Format' field to enter the number format and 'Block’, 'Port' drop-
down boxes to select the data source.
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LED layouts:

Layout 0
Layout 1

Input: @ﬁ]

Selected variable

Format (e.g. X0.0, 400, X0) x0
X: decimal or space if number is small
0: decimal or 0 placeholder
+: sign is always visible

Block [Digital input

~] Port[oUT: value 1 ~]

16.62.  Extended - Custom PolL
Description Custom PolL for custom PolL code - double-click on block to edit code
Inputs Up to 10 inputs of various types
Outputs Up to 10 outputs of various types
Properties None
Remarks None
16.1. Extended — ST block
Description ST code block - double-click on block to edit code
Inputs Up to 10 inputs of various types
Outputs Up to 10 outputs of various types
Properties None
Remarks None
16.2. Extended - Byte to bits
Description Byte to bits extracts individual bits from the byte variable on input, bit 0 being least-
significant one
Inputs In (8-bit integer): Input variable
Outputs Bit 0-7 (Logic): Bit O (LSb) - Bit 7 (MSh)
Properties None
Remarks None
16.3. Extended - Bits to byte
Description Bits to byte joins individual bits to the byte variable on output, bit 0 being least-
significant one
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Inputs
Outputs
Properties
Remarks

16.4.

Description
Inputs

Outputs
Properties

Remarks

16.5.

Description
Inputs

Outputs
Properties

Remarks

16.6.

Description
Inputs

Outputs

Properties

Bit 0 (Logic): Bit 0 (LSb) - Bit 7 (MSh)
Out (8-bit integer): Output variable
None
None

Control - On/off

On/off

PV (32-bit integer): Process Variable input (current value of the controlled variable)

SP (32-bit integer): Set Point

Out (32-bit integer): On/Off controller output

Gain (Integer): Controller gain

Hysteresis (Integer): Half of the controller hysteresis - the difference between turn-

on and turn-off points . The controller turns on at PV < SP-hysteresis/2 and turns off
at PV > SP+hysteresis/2

None

Control - PID

PID (PID controller) is an implementation of a standard PID controller with filtered D-
part and output limits with integral anti-windup protection.

PV (32-bit integer): Process Variable input (current value of the controlled variable)
SP (32-bit integer): Set Point

Out (32-bit integer): PID controller output (in the range from Out min to Out max

K (Floating point): Proportional gain

Ti (Floating point): Integral time constant in seconds

Td (Floating point): Derivative time constant in seconds

Tf (Floating point): Derivative filter time constant - set to a fraction of Td

Out min (Integer): Output lower limitation (minimum output value)

Out max (Integer): Output upper limitation (maximum output value)

When cycle time of the project is set to 0, PID block can not be used in the diagram
due to improper timing.

Communication - 1-wire R/W

1-wire write and read operation block

ICLK (Logic/clock): Inverted clock input signal

Write 1 - 10 (8-bit integer): Bytes 1 - 10 to write to 1-wire device

Busy (Logic): Busy signal

Read 1 - 10 (8-bit integer): Bytes 1 - 10 that are read from 1-wire device
Write count (Integer, 0 to 10): Number of bytes to write to 1-wire bus
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Read count (Integer, 0 to 10): Number of bytes to read from 1-wire bus

Remarks Communication is started on falling edge of the ICLK input in order to support
chaining multiple communication blocks using busy signals - when one device
completes the communication session, its Busy signal goes from 1 to 0, which then
triggers a communication session on another block in the chain.

16.7. Communication - 12C read

Description 12C read operation block
Inputs ICLK (Logic/clock): Inverted clock input signal

Address (8-bit integer): 12C device address

Outputs Busy (Logic): Busy signal
Error (Logic): Error signal
Read 1 - 10 (8-bit integer): Bytes 1 - 10 to be read from 12C device

Properties Read count (Integer, 0 to 10): Number of bytes to read from I1°C device

Remarks Communication is started on falling edge of the !CLK input in order to support
chaining multiple communication blocks using busy signals - when one device
completes the communication session, its Busy signal goes from 1 to 0, which then
triggers a communication session on another block in the chain.

16.8. Communication - 12C write

Description |>C write operation block
Inputs ICLK (Logic/clock): Inverted clock input signal

Address (8-bit integer): I1°C device address
Write 1 - 10 (8-bit integer): Bytes 1 - 10 to write to I12C device

Outputs Busy (Logic): Busy signal
Error (Logic): Error signal

Properties Write count (Integer, 0 to 10): Number of bytes to write to 1°C device

Remarks Communication is started on falling edge of the !CLK input in order to support
chaining multiple communication blocks using busy signals - when one device
completes the communication session, its Busy signal goes from 1 to 0, which then
triggers a communication session on another block in the chain.

16.9. Misc - Comment

Description Comment is used to enter comments
Inputs None
Outputs None
Properties Comment: Comment text
Remarks None
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16.10.

Description

Inputs
Outputs
Properties
Remarks

16.11.

Description
Inputs
Outputs
Properties
Remarks

16.12.

Description
Inputs
Outputs
Properties

Remarks

16.13.

Description
Inputs
Outputs
Properties

Remarks

Misc-To

To is used to route signals across the schematic. To connect To and From blocks,
identical Link ID must be specified.

>>>: Input port of the link

None

Link ID (Integer): Link ID - see block description

Only one 'To' block can be specified for one Link ID, while multiple 'From' blocks can
be specified for the same Link ID

Misc - From

From is used to route signals across the schematic

None

>>>: Output port of the link

Link ID (Integer): Link ID - see block description

Only one 'To' block can be specified for one Link ID, while multiple 'From' blocks can
be specified for the same Link ID

Misc - Shared 1-bit

Shared 1-bit simulates a simple memory latch for use with shared slots.

None

(Logic): Stored integer data

Default value (Logic): Default reset value

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.

Initial value (Logic): The initial value of the retained block after it gets uploaded to
the device.

None

Misc - Shared 8-bit

Shared 8-bit simulates a simple memory latch for use with shared slots.

None

(8-bit integer): Stored integer data

Default value (Integer): Default reset value

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.

Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.

None
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16.14. Misc - Shared 16-bit

Description Shared 16-bit simulates a simple memory latch for use with shared slots.
Inputs None
Outputs (16-bit integer): Stored integer data
Properties Default value (Integer): Default reset value

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.
Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.

Remarks None

16.15. Misc - Shared 32-bit

Description Shared 32-bit simulates a simple memory latch for use with shared slots.
Inputs None
Outputs (32-bit integer): Stored integer data
Properties Default value (Integer): Default reset value

Retain on reset (Logic): If True, the value is saved to battery-backed RAM. Also
disables default value setting.
Initial value (Integer): The initial value of the retained block after it gets uploaded to
the device.

Remarks None
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17.Structured text (ST) block

Structured text, abbreviated as ST, is one of the five languages supported by the IEC 61131-3 standard,
designed for programmable logic controllers (PLCs). PoBlocks supports entering the ST code that is
translated into a function block, which is then included in the PoBlocks diagram.

W poBlocks 2.0.00 - o x

L &B8 | Check and Transfer

File Edit  View Tools Help

10 Algebra Logic Memory Trigger /timing [2NSU:CeM Control Communication Misc

- T _)E E:‘! = | ]/_' o - Poll ST ﬂ\ \zf
£ EhH Q) W Al ] ] e <> <>
D Eyent dum “’"‘E;;L‘)Eb‘a Schedue  Multiplexern-1  Deadband T Resce LDUI  CustomPoll  STbock  Byletobits  Bitstobyte
Project Properies
o poBlocks ? X
Comple | OK Cancel
ST kaCk 1 FUNCTION BLOCK block
(JInputl Outputl| 2 VAR _INPUT
3 Inputl : INT:
L{Input2 2 Inputz : INT;
-4 5 END VAR
ST block .
7 VAR OUTPUT
f Gutputl : INT:
5 END VAR
10
11| var
12 top : INT;
13 END VAR
14
15 tmp := Tnputl * Tnput2:
16 Outputl := Inputl - tmp:
17 END FUNCTION BLOCK
<
Mouse: [263, 111] F210007
Compile succeeded

Since the target application of this block is to represent the ST code as a diagram block, PoBlocks expects
exactly one FUNCTION_BLOCK declaration in the code with inputs and outputs specified in VAR_INPUT
and VAR_OUTPUT variable declaration blocks. Custom (static) variables can be declared in the VAR
declaration block.

There can be additional FUNCTION declarations in front of the main function block.

PoBlocks implementation supports the following ST data types:

BOOL (Boolean value)

INT (32-bit integer)

REAL (32-bit floating point value) - to use the REAL data type, 'OPTION_ENABLE FLOAT;' must be
included in the first code line of the block.

TIME (relative times with 1 ms precision)

The following functions are built-into the support:
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e time_ms() : INT - returns the current value of the millisecond system timer

e abs(x:INT): INT - absolute value of parameter x

e real(x: INT) : REAL - converts integer into floating point

e int(x : REAL) : INT - converts floating point value into integer

e read_memory_B(address : INT) : INT - reads the PoBlocks memory address — byte (8-bit)

e read_memory_W(address : INT) : INT - reads the PoBlocks memory address — word (16-bit)

e read_memory D(address : INT) : INT - reads the PoBlocks memory address — double-word (32-
bit)

e write_memory_B(address : INT, value : INT) - writes value to the PoBlocks memory address —
byte (8-bit)

e write_memory_W(address : INT, value : INT) - writes value to the PoBlocks memory address —
word (16-bit)

e write_memory_D(address : INT, value : INT) - writes value to the PoBlocks memory address —
double-word (32-bit)

e PE get state () : INT - returns current Pulse engine state

e PE_set state (state : INT) - sets current Pulse engine state

e PE_get position (axis : INT) : INT - returns current Pulse engine axis position (axis indexes
between 0 and 7)

e PE_set position (axis : INT, position : INT) - sets current Pulse engine axis position (axis indexes
between 0 and 7). This function shall only be called when there is no motion on the axis.

e PE_home (axisMask : INT) - initializes homing procedure for axes specified by the bit mask (bit 0
- axis 0, bit 7 - axis 7). Multiple axes can be homed at the same time.

e PE_move_PV (axis : INT, reference : INT, speed : REAL) - starts a move towards the reference
position with the provided relative speed (0.0 - 1.0 range equals to 0 - max axis speed).

e PE_G1 (speed : INT, x : INT, y : INT) - starts a semi-G1 coordinated move towards the reference
position x, y with the given pulse velocity

o PE_G1_xyz(speed:INT, x:INT,y:INT, z: INT) - similar as PE_G1, but in 3 coordinates x,y,z

e bit_shift_left(x : INT, y: INT) — left bit shifted value of y by x bits

e bit_shift_right(x : INT, y: INT) — right bit shifted value of y by x bits

PoBlocks also support instantiation of the following system function blocks:

e ton(IN:BOOL, PT:TIME) ->Q: BOOL, ET : INT) - On timer
e tof(IN: BOOL, PT: TIME) -> Q : BOOL, ET : INT) - Off timer
e tp(IN:BOOL, PT:TIME)->Q:BOOL, ET : INT) - Pulse timer

To check the code for errors and compile it, click the ‘Compile’ option at the top. If no errors are found,
message ‘Compile succeeded’ will be shown and the code can be used as a block in the PoBlocks
diagram.
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18.Grant of license
The material contained in this release is licensed, not sold. PoLabs grants a license to the person who
installs this software, subject to the conditions listed below.

Access
The licensee agrees to allow access to this software only to persons who have been informed of and
agree to abide by these conditions.

Usage
The software in this release is for use only with PolLabs products or with data collected using PolLabs
products.

Copyright

PolLabs claims the copyright of, and retains the rights to, all material (software, documents, etc.)
contained in this release.

You may copy and distribute the entire release in its original state, but must not copy individual items
within the release other than for backup purposes.

Liability
Polabs and its agents shall not be liable for any loss or damage, howsoever caused, related to the use of
Polabs equipment or software, unless excluded by statute.

Fitness for purpose

No two applications are the same, so Polabs cannot guarantee that its equipment or software is
suitable for a given application. It is therefore the user's responsibility to ensure that the product is
suitable for the user's application.

Mission Critical applications

Because the software runs on a computer that may be running other software products, and may be
subject to interference from these other products, this license specifically excludes usage in 'mission
critical' applications, for example life support systems.

Viruses
This software was continuously monitored for viruses during production, however the user is
responsible for virus checking the software once it is installed.

Support
No software is ever error-free, but if you are unsatisfied with the performance of this software, please
contact our technical support staff, who will try to fix the problem within a reasonable time.

Upgrades
We provide upgrades, free of charge, from our web site at www.poscope.com. We reserve the right to
charge for updates or replacements sent out on physical media.

Trademarks
Windows is a registered trademark of Microsoft Corporation. PoKeys, PoKeys55, PoKeys56U,
PoKeys56E, PoScope, PoLabs and others are internationally registered trademarks.
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